Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

Permit: Date:

Development: Stormwater

Inspector: Location:

» The Texas Pollutant Discharge Elimination System (TPDES) Construction General Permit (CGP) to the

maximum extent possible all discharges of storm water from the project site be composed entirely of storm water — no

sediments, hazardous materials, petroleum products, litter, construction debris, ezc. shall be discharged to surface
waters in the state, waters of the United States, and a permitted Municipal Separate Storm Water Sewer System.

A. Large Construction Project

» Is this a Large Construction Project? That is, a construction activity including clearing, grading,

and excavating that results in disturbance of equal to or greater than 5 acres of land. 0 Yes 0O No
Large construction activities also include the disturbance of less than 5 acres of land that is a ON/A
part of a common plan of development if the larger common plan will uitimately disturb
equal to or greater than feet acres of land.
B. Small Construction Project
» Is this a Small Construction Project? That is, a construction activity including clearing, grading,
and excavating that results in disturbance of equal to or greater than 1 acre of land and less than 5 O Yes O No
acres of land. O N/A
Small construction activities also include the disturbance of less than 1 acre of land that is a
part of a common plan of development if the larger common plan will ultimately disturb
equal to or greater than 1 acre of land.
C. Projects Less Than One Acre in Size
» Is this project less than 1 acre in size (and is not a part of a larger, common develop that will O Yes 0 No
ultimately disturb an area greater than 1 acre)? O N/A
If so, TxDOT requires we have a SW3P appropriate to the project.
D. Permit Review
» Does the construction site qualify for a Texas Pollutant Discharge Elimination System (TPDES) O Yes o<1
permit — that is, is it a Large or Small Construction Project? (if not, it must be less than 1 acre in size) acre
E. Notice of Intent (NOI) to Discharge Storm Water from a Construction Site — When to File
» Is the project a Large Construction Project? If so, a NOI must be submitted to the Texas O Yes O No
Commission on Environmental Quality (TCEQ) along with required payment. 0O N/A
» Is the project a Small Construction Project? If so, a NOI is not required. O Yes 0 No
ON/A
» Will the project discharge water to a permitted Municipal Separate Storm Water Sewer System O Yes 0 No
(City of Donna streets, gutters, right-of-way, drainage easements, storm drains, playa lakes)? O N/A
if so, has a copy of the NOI (or Construction Site Notice, if it is a Small Construction
. : [0 Yes O No
project) been forwarded to the City of Donna?
; o ON/A
F. Notice of Intent (NOI) to Discharge Storm Water from a Construction Site — Contents (for k
Large Construction Projects only)
» Does the NOI contain the name, address, and telephone number of the operator filing the NOI? O Yes 00 No
0O N/A
» Does the NOI contain the name (any other identifiers), address, county, and latitude / longitude of O Yes 0 No
the of the construction project? 0O N/A
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

» Does the NOI contain conformation that a SW3P has been developed and that the SW3P will be O Yes 0 No

compliant with any applicable local sediment and erosion control plans? O N/A

» Does the NOI contain the name of the receiving waters? 3 Yes O No
ON/A

G. Does the TPDES Construction Site Notice contain the following infofmation?

» The TPDES Permit number? (If you do not currently have a permit number, post the Construction O Yes 0 No

Site Notice and as soon as the permit number arrives add the permit number to the notice.) O N/A

» The name and telephone number of the local contact person? O Yes O No

» A brief description of the project? O Yes 0 No
Does this description include an estimated start date and projected end date or the date that 0O Yes O Ne

disturbed soils will be stabilized?

» The location of the Storm Water Pollution Prevention Plan (SW3P)? [ Yes 00 No

» Is the Construction Site Notice for Large Construction Activities posted? O Yes 0 No
O N/A

» Is the Construction Site Notice for Small Construction Activities posted — the area engineer must O Yes O No

sign this form? 0O N/A

H. Bulletin Board — Posting Requirements

> Does the project bulletin board contain the Consfruction Site Notice? (all projects must have the M Yes O No
Construction Site Notice posted regardless of the size [large or small] of the project)

v Does the project bulletin board contain the NOI? (for Large Construction Projects only) O Yes O No

ONA
» Does the project bulletin board contain the TCEQ permit? (for Large Construction Projects only) 0O Yes 00 No
ON/A

1. Bulletin Board — Other Requirements

T The CUGP Construction Site Notice posted niear the enirance fo the project—on the project or O Yes O No

SW3P bulletin board?

» Is the Construction Site Notice posted on-site even if there is not a field office? 0 Yes 0O No
ON/A

» Was the Construction Site Notice posted priof to the start of construction? O Yes 0 No

J. Signature Authority

v Is the “Signature Authority and Delegation” in the SW3P? 0 Yes 0O No
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

K. General Conditions

» Does the facility have adequate storm water controls—have the BMPs been evaluated on-site for O Yes 0 No
effectiveness)? ;
» Are silt fences or equivalent sediment controls used for all side-slope and down-slope boundaries of | O Yes 0 No
the construction area?
L. Are there control measures to:
» Prevent off-site tracking of mud and solvents? 3 Yes 0 No
0 N/A
» Minimize dust generation? [0 Yes 0 No
‘O N/A
» Prevent discharges of solids and building materials? O Yes 0O No
O N/A
M. Storm Water Pollution Prevention Plan (SW3P) — Deadlines
» Was the SW3P completed prior to obtaining authorization to discharge storm water under the 0 Yes 0 No
TPDES Construction General Permit?
» Was the SW3P implemented prior to the start of construction activities that result in soil disturbing | O Yes O No
activities?
N. Storm Water Pollution Prevention Plan (SW3P) — Location
» Is a copy of the SW3P on-site at the facility that generates storm water discharges (the construction | [J Yes 0 No
site field office)? O N/A
» If the SW3P is not on-site is a Construction Site Notice on-site and does the Construction Site 0 Yes 1 No
Notice state the location of the SW3P? O N/A
O. Storm Water Pollution Prevention Plan
» Does the SW3P contain a description of the nature of the construction activity? O Yes 0 No
» Does the SW3P contain a description of potential project pollutants? 0 Yes 0 No
» Does the SW3P contain a description of potential project pollutant sources? O Yes O No
» Does the SW3P contain a description of the intended schedule or sequence of major activities that O Yes 0O No
will disturb soils for major portions of the site?
» Does the SW3P contain the number of acres of the entire construction site property and the total
number of acres of the site where disturbed soils will occur? O Yes 0 No
Do these totals include off-site material storage areas, overburden and stockpiles of dirt, and | O Yes 0 No

borrow areas?
o Note: Does the SW3P note that Project Specific Locations (PSLs) (e.g., field offices,
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

material storage areas, overburden and stockpiles of dirt, borrow sites) beyond the project

right-of-way have “individual operator” status under the TPDES Construction General O Yes 0 No
Permit and that the SW3Ps for those “PSLs beyond the right-of-way are the responsibility of ONA
the project contractor.”
oNote: Once all off-site PSLs have been established by the contractor, the SW3P must be 1 Yes 1 No
revised to show or describe the locations of the off-site PSLs and the responsible operator.
- O N/A
Has this been done?
» Does the SW3P contain a map showing the general location of the construction site? O Yes 0 No
» Does the SW3P include a detailed map indicating the following:
o drainage patterns and approximate slopes anticipated after major grading activities? O Yes O No
o areas where soil disturbance will occur? O Yes 0 No
o locations of all major structural controls either planned or in-place? O Yes O No
o locations where stabilization practices are expected to be used? O Yes O No
o locations of off-site material, waste, borrow, equipment storage areas, asphalt and concrete | O Yes 0O No
plants, or any other Project Specific Locations within one mile of the project that provide O N/A
support to the construction site within one mile of the project?
o the location of surface waters (including wetlands) either adjacent to or in close proximity | O Yes 0 No
to the project? O N/A
o the locations where storm water discharges from the site directly to a surface water body? | O Yes 0 No
O N/A
» Does the SW3P contain the names of receiving waters at or near the project that will be disturbed or | O Yes 0 No
will receive discharges from disturbed areas of the project? o N/A
» Does the SW3P contain a copy of the TPDES Construction General Permit? O Yes 0 No
P. Duty to Keep Current
» If there is a change of design, construction, operation, or maintenance that has a significant effect on
the discharge of pollutants that has not previously been addressed in the SW3P the SW3P must be 01 Yes 0 No
amended to reflect this change — has this been done? 0o N/A
» Do inspections or investigations indicate the SW3P is ineffective in eliminating or significantly
minimizing pollutants from the construction site? O Yes O No
» Do inspections or investigations indicate the SW3P is not achieving the general objectives of
controlling pollutants? 0O Yes O No
» If through inspections, it is determined that best management practices are not operating effectively,
maintenance must be performed before the next anticipated storm event or as necessary to maintain O Yes 0 No

the effectiveness of storm water controls — is this being done?

Q. Inspection of Controls

» Are inspectors familiar with the SW3P inspecting the following locations every seven days?
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

Disturbed areas of the construction site that have not been finally stabilized?
Areas used for storage of materials that are exposed to precipitation?
Structural control measures?

Locations where vehicles exit the site?

» Are inspectors familiar with the SW3P inspecting accessible discharge locations to determine if
erosion control measures are effective in preventing visually noticeable changes to the receiving
waiters? (The frequency of these inspections must be established by the district in the SW3P with
consideration for local rainfall and soils.)
To the maximum extent practicable, where discharge locations are inaccessible, are
inspectors inspecting nearby downstream locations (this inspection must occur at least once
during the construction activity if a discharge occurs)?

» Based on the results of inspections, is the SW3P being modified to better control pollutants in
runoff?

Are revisions to the SW3P being completed within seven calendar days following the
inspection.

If existing best management practices are modified or additional best management practices
are necessary, an implementation schedule must be described in the SW3P. Wherever
possible, those changes must be implemented before the next storm event—is this being
done?

If implementation before the next storm event is impracticable, are needed changes being
implemented as soon as practicable?

» Are the names and qualifications of the inspectors retained as a part of the SW3P?

» Has a report summarizing the scope of the inspection, the dates of inspections, and major
observations relating to the implementation of the SW3P been completed and retained as a part of the
SW3P?

» Major observations should include:

o the locations of discharges of sediments or other pollutants from the site
o the locations of best management practices that need to be maintained

o the location of best management practices that failed to operate as designed or proved
inadequate for a particular location

o the locations where additional best management practices are needed

» Reports must identify incidents of non-compliance — is this being done?

» Where a report does not identify any incidents of non-compliance, the report must contain a
certification that the facility or site is in compliance with the SW3P and this permit.
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

» Has the inspection report been signed by the contractor’s representative? O Yes O No
» Has the inspection report been signed by the project inspector? 0 Yes 0 No
» Has the inspection report and the certification statement been signed by the area engineer, assistant | O Yes O No
area engineer, project engineer or chief project inspector?
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SELF VISUAL INSPECTION CHECKLIST FOR GENERAL TPDES
PERMIT FOR STORMWATER DISCHARGES ASSOCIATED WITH
CONSTRUCTION ACTIVITIES

Note: It is a condition of TPDES permits that a visual inspection is conducted by the permittee and all co-
permittees on a weekly basis and after every measurable rainfall event. Failure to conduct the
required inspection may result in permit suspension or the imposition of civil penalties.

Inspection Type (check one): Weekly [] Post Rain Event [']
Date: Time: Inspector Name:
Submitted weekly to MS4 (date); to (Name):
Y N NA
1. Approved (stamped & signed) Erosion & Sediment (E&S) plan present on
site? O O

Comments/Repairs made (if applicable):

2. Are there activities occurring outside of the limits of disturbance shown on the plan drawings? O O

Comments/Repairs made (if applicable):

3. Are areas intended for BMP's protected from compaction? O 0

Comments/Repairs made (if applicable):

4. ldentify the Stage(s) of Construction (BMP) Sequence the jobsite is at? E & S BMPs 0 0O
identified in the Sequence up to that stage installed properly?
Comments/Repairs made (if applicable):

5. Construction Entrance(s) installed correctly at locations shown on plan drawings?
a. Construction entrance(s) installed as per the plan detail(s)?
b. Construction entrance(s) properly maintained?

oooo
ooogd
oooad

¢.  Public roadways kept clean of tracked mud?
Comments/Repairs made (if applicable):




Y N NA
6. Off-site discharges 0O O
a. Turbid water leaving site? O O
b. Turbid water entering a surface water? O O
c. Evidence of sediment pollution from accelerated erosion entering a surface water? O O
d. Evidence of previous undocumented sediment pollution to a surface water? O Od
Comments/Repairs made (if applicable):
7. Clearing & Grubbing O d
a. Perimeter BMPs installed concurrently with clearing operations? O O
b. Are perimeter BMPs installed prior to general site clearing and grubbing? J d
c. Arelwere stabilized crossings (as specified in the plan) used at all stream/wetland [] [
crossings?
Comments/Repairs made (if applicable):
8. Work within stream channels/wetlands being conducted as specified in the plans? 0O O O
a. Base flow bypassing work area as per plans? 0O O O
b. Disturbed areas returned to original contours and stabilized as per plan upon completon [] [ [J
of work?
Comments/Repairs made (if applicable):
9. Water pumped from work areas treated in the manner prescribed by the plan prior to [ [ [
discharge to a surface water?
a. Filter bags installed, used, & maintained properly? O O 0
b. Vegetated filter strips functioning properly and maintained properly?
c. Other devices installed, used, & maintained properly? O o
Comments/Repairs made (if applicable):
10. Silt fence installed where shown on plan drawings? O O 0O
a. Installed on existing level grade? O O O
b. Properly anchored? O O O
c. Stakes meet plan specifications? O O O



d. Fences properly maintained?
i. Sediment removed when at ¥ above-ground height of fence?
ii. Undercut or overtopped fence replaced with rock filter outlet?

iii. Torn or weathered fence replaced?
Comments/Repairs made (if applicable):

MEEEEEEES
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N/A

11. Compost socks installed where shown on plan drawings?
a. Socks instalied on level grade?
b. Properly staked?
c. Properly maintained?

i. Sediment removed when % height of sock?

ii. Undercut or overtopped socks repaired & concentrated flows directed away from
sock?

iii. Torn or damaged sock repaired/replaced?
Comments/Repairs made (if applicable):

O oooooo
o ouooooo
O O0O0OoOooo

12. Stabilized access provided to trap and/or basin locations as shown on plan drawings?

a. Any evidence of runoff problems due to the access roads?
Comments/Repairs made (if applicable):

ogd

ug
oagd

13. Sediment traps installed where shown on plan drawings?
a. Embankment properly constructed?
i. Does the embankment lack compaction?
ii. Side slopes over steep?
iii. Any low points?
iv. Embankment vegetated or blanketed (if newly constructed)?
v. Any tension cracks evident along the top?
vi. Any evidence of piping (holes in embankment)?
b. Barrel/Riser Spillways located where shown on plan?
i. Any elevation problems (e.g. riser higher than embankment, etc.)?

ii. Any perforation problems (holes located at bottom of trap, too many holes, holes
larger or smaller than 1" dia.)?

iii. Trash rack & antivortex device shown on plan drawings provided?
iv. Riser has water-tight connection to outlet barrel?

v. Any leaking problems (scouring or holes at base of riser, sound of running water
with water level below lowest hole)?
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vi. Any piping around outlet barrel?
vii. Spillway properly maintained?
1. Holes not plugged?
2. Damaged risers repaired/replaced?

Comments/Repairs made (if applicable):

OOoOood-<
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C.

@ ™

j

Embankment spillways located where shown on plan?
i. Stone is the correct size per the plan?
ii. Stone lower in center than at sides?

iii. Layer of filter stone on inside face of spillway?

iv. Filter fabric securely staked on top of filter stone up to top of sediment storage
elevation?

v. Spillway properly maintained?
1. Clogged spillway repaired/replaced?
2. Damaged/displaced filter cloth replaced/restaked?
Skimmers installed as per plan details?
i. Attachment to permanent riser or outlet barrel appears to be water-tight?
ii. Skimmer has a stable landing place?
ii. Any problems with the flexible hose?
Outlet protection installed as shown on plan drawings?
i. Stone is the correct size per the plan?
ii. Discharges are safely conveyed to receiving surface water?
iii. OQutlet protection properly maintained?
1. Any signs of rock displacement?
2. Any sediment deposits on apron?
3. Any erosion around or below apron?
Trap interior stabilized?
Any evidence of slope failure inside the trap?
Any evidence of sink holes developing inside the trap?
Are baffles, silt curtains, forebays provided as shown on the plan drawings?
Has suitable protection been provided at the inflows as shown on the plans?

Comments/Repairs made (if applicable):

Oodbooooooooaogooooo oooood
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14. Sediment Basins installed where shown on the plan drawings?

a.

Embankment properly constructed?
i. Does the embankment lack compaction?
ii. Side siopes over steep?
iii. Any low points?
iv. Embankment vegetated or blanketed (if newly constructed)?

-4
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b.

h.

j-

Comments/Repairs made (if applicable):

v. Any tension cracks evident along the top?
vi. Any evidence of piping (holes in embankment)?
Barrel/Riser Spillways located where shown on plan?
I.  Any elevation problems (e.g. riser higher than embankment, etc.)?

ii. Any perforation problems (holes located at bottom of basin, too many/few holes,
holes larger or smaller than 1" dia.)?

iii. Trash rack & antivortex device shown on plan drawings provided?
iv. Riser has water-tight connection to outlet barrel?

V. Any leaking problems (scouring or holes at base of riser, sound of running water
with water level below lowest hole)?

vi. Any piping around outlet barrel?
vii. Riser properly maintained?
1. Holes not plugged?
2. Damaged risers repaired/replaced?
Skimmers installed as per plan details?
i. Attachment to permanent riser or outlet barrel appears to be water-tight?
ii. Skimmer has a stable landing place?
ii. Any problems with the flexible hose?
Emergency Spillway constructed at the location shown on the plan drawings?
i. Any dimension problems (width of spillway, size of rock, depth of spillway)?
ii. Was the spillway choked with rock?

iii. Has an outlet channel been provided for the emergency spillway as shown on the
plan drawings?

Outlet protection installed as shown on plan drawings?
i. Stone is sized properly per the plan?
ii. Discharges are safely conveyed to receiving surface water?
iii. Outlet protection properly maintained?
1. Any signs of rock displacement?
2. Any sediment deposits on apron?
3. Any erosion around or below apron?
Basin interior stabilized?
Any evidence of slope failure inside the basin?
Any evidence of sink holes developing inside the basin?
Are baffles, silt curtains, forebays provided as shown on the plan drawings?
Has suitable protection been provided at the inflows as shown on the plans?
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15.  Are all channels constructed at the locations shown on the plan drawings?

a.

b.

Any dimension or shape problems (smaller than details show, V-channel instead of
trapezoid, etc.)?

Have the protective linings been installed as specified?
-5.-
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Y
Are there any gradient problems (standing water, sediment deposits)? L] [b_f] r‘I%IQ
Are there any flow obstructions (large rocks, soil slips, straw bales, non-culverted O o o
crossings, etc.)?
e. Any erosion problems? O O 0O
f Any out-of-channel flow problems (erosion trails leading away downslope from the [1 [ [
channel)?
g. Any failures of the channel linings? O O Od
h. Do collector channels enter basins/traps on the upslope sides? O O O
i.  Any disturbed areas above diversion channels? O 0O O
j.  Any disturbed areas below collector channels with no additional BMPs? O O O
Comments/Repairs made (if applicable):
16. Are slope pipes installed where shown on the plans? O 0O O
a. Are they water-tight? O O 0O
b. Are they anchored? O O 0O
c. Has runoff been directed to the head of the pipe? O O O
d. Has outlet protection been provided per the plans? O O Od
Comments/Repairs made (if applicable):
17. Are trenching operations being conducted at the locations & in the manner shownonthe [ [0 [
plan drawings?
a. Are area limitations being followed? O O 0O
b. Are stream crossings being conducted in the proscribed manner? O O O
i. Base flow bypassed as specified? O O O
ii. Disturbed areas within 50’ of top-of-bank blanketed? O O O
¢. Are trench plugs being used as specified? O 0O O
d. Are waterbars being installed on backfilled areas? O O O
Comments/Repairs made (if applicable):
18. Has inlet protection been installed at the locations shown on the plans? O OO 0O
a. Isthe type of inlet protection shown in the approved plans installed? O O O
b. Was it installed according to the details? O O O
¢. Does any of the inlet protection need to be cleaned or replaced? O O 0O

Comments/Repairs made (if applicable):




Y N NA
19. Is stabilization being kept current with final grade? O O
a. Cut & fill slopes stabilized in regular vertical increments. O O
b. Erosion control blanketing installed where shown on the plans & according to the plan  [] [
details?
c. Erosion gullies addressed & stabilized in a timely manner? 0o d
d. Poorly vegetated areas reseeded? O g
Comments/Repairs made (if applicable):
20. Final stabilization achieved? 0o O
a. Vegetated areas meet “uniform 70%, perennial vegetation” requirement? O O
b. Non-vegetated areas have a stable erosion-resistant surface? O O
Comments/Repairs made (if applicable):
21. Pictures taken to document findings of the inspection (good and bad)? N
Comments/Repairs made (if applicable):
22. Inspection report completed on site? O O
a. All parts of the report filled out? O O
b. Contents of the report discussed with site representative along with possible meansto  [] [
correct deficiencies where needed?
Comments/Repairs made (if applicable):
23. Are the measures or activities that are installed (or being installed) to address post- [] []

construction stormwater runoff properly installed and maintained to function as designed
after the site has been stabilized?

Comments/Repairs made (if applicable):

Signature

Title







St

Sec. 26-34. - Drainage.

(a)

(b)

(

Easement. Where a subdivision is traversed by a watercourse, drainageway, natural channel,
stream or where there is a necessity for such as determined by the planning and zoning
commission, there shall be provided an easement or right-of-way conforming substantially to
the limit of such watercourse. A 75-foot drainage ditch easement shall be required from the
centerline of the drainage ditch, unless the City of Weslaco Master Storm Water Drainage
Plan indicates otherwise. A minimum of a ten-foot access roadway for maintenance shall be

required on the perimeter of the drainage ditch.

Drainage facilities. Drainage facilities shall be provided and constructed at the expense of the
subdivider pursuant to the city drainage policy and as specified and/or approved by the city
engineer.

Drainage policy. No subdivision will be approved unless calculations submitted by the project
engineer show that the projected runoff for the proposed subdivision, based on a twenty-
five-year flood event, will not be greater than the natural runoff, Any water in excess of
natural runoff must be detained on-site and released at existing ten-year flood rate. These
flows may be exceeded only if off-site improvements and/or facilities are provided which, in
the opinion of the city engineer and the planning and zoning commission, serve as adequate
drainage facilities. Any property must provide an amount of floodwater storage capacity after
development, which is not less than the preexisting floodwater storage capacity of such
property during the 100-year flood, regardless of whether such preexisting flood storage
capacity is due to natural or artificial causes. The project engineer shall provide such
information as required by the city to demonstrate compliance with the city drainage policy.

Twenty-five-year flood detention is required for all developments except for two cases:

i. Small projects. The table below identifies small projects.

SMALL PROJECT EXCEPTION DESCRIPTION

1. Construction of a building or parking lot if the proposed construction does not require
a variance from a water quality regulation, does not exceed 5,000 square feet of
impervious cover and the construction site does not exceed 10,000 square feet
(includes construction, clearing, grading, construction equipment access, driveway
reconstruction, temporary installations, landscaping and other areas planning director

or city engineer determine part of construction site).

2. Construction of a storm sewer not more than 30 inches in diameter that is entirely on

public right-of-way or easement.




3. Construction of a utility line not more than 8 inches in diameter that is entirely in

public right-of-way.

4. Construction of a left turn lane on a divided arterial street.
5. Construction of street intersection improvements.
6. Widening of public street to provide a deceleration lane if additional right-of-way is

not required.

7. Depositing less than two feet of earth fill, if site is not in the 100 year floodplain and

the fill is not to be deposited within the dripline of a protected tree.

8. Minor development that the planning director and/or city engineer determine similar

to items described above.

ii. Storm water quality. In an attempt to help reduce the amount of pollutant being
discharged into the Arroyo Colorado Watershed, city will consider reducing the amount
of storm water detention, if low impact development techniques are used to hold storm
runoff. There are many practices that have been used to adhere to these principles
such as bioretention facilities, rain gardens, vegetated rooftops, rain barrels, and
permeable pavements. City engineer must approve these techniques and quantities

before storm detention requirement is reduced.

(d) Existing facilities. Facilities currently discharging storm water to streets without detention will
be required to detain storm water run-off if a building permit is requested, if the building
does not meet small project exception. The minimum detention requirements shall be based
on the building being constructed or remodeled. The storm water run-off may be detained in
the landscaped area.

(e) Lot grading: All lots shall be graded so that storm water run-off is directed to the street
fronting the lot. If a lot has double frontage, the city engineer and/or planning director may
allow for the drainage of the lot to be split such that a portion of the run-off is directed to the
street in front of the lot with the remainder of the run-off directed to the street at the rear of

the lot.
(Ord. No. 2013-22, § 1l, 10-15-2013)




